
1 

 

Technical Paper 
November 2001 

 

CADD/GIS 
Technology Center 

Implementing the Spatial Data Standard 
(SDSFIE)/Facility Management Standard 
(FMSFIE), Release 2.00 Using AutoDesk, Inc. 
AutoCAD Map 2000i 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The CADD/GIS Technology Center 
  for Facilities, Infrastructure, and Environment 
Army Engineer Research and Development Center (at Vicksburg) 
3909 Halls Ferry Road 
Vicksburg, MS  39180-6199 
 
 

 



2 

 
FOREWORD 

 
The CADD/GIS Technology Center for Facilities, Infrastructure, & Environment (i.e., the Center) is 
responsible for the design, development and maintenance of the Spatial Data Standard for Facilities, 
Infrastructure, and Environment (SDSFIE), and the Facility Management Standard for Facilities, 
Infrastructure, and Environment (FMSFIE).  These Standards are being developed so GIS and CADD 
users within the CADD/GIS community can easily transfer and communicate data and information.  The 
FMSFIE is being designed to integrate with the SDSFIE and the A/E/C CADD Standards and will 
consider business processes and more detailed analysis and reporting data requirements.  The SDSFIE 
was called the Tri-Service Spatial Data Standards (TSSDS) prior to July 1999).  The FMSFIE was called 
the Tri-Service Facility Management Standards (TSFMS) prior to July 1999).  The acronyms SDS and 
FMS were used from July 1999 until January 2001.  The SDSFIE/FMSFIE Release 2.00 was completed in 
January 2001. 
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1 Introduction 

This paper provides basic information and instructions for implementing the SDSFIE/FMSFIE using AutoCAD Map 
GIS software.  Additional information about the SDSFIE and FMSFIE is available from the CADD/GIS Technology 
Center at http://tsc.wes.army.mil.   
 
GIS Software 
 
The instructions are based upon the functionality and capabilities of AutoDesk AutoCAD Map 2000i (Release 4.5) 
GIS software.  Additional information, and more detailed instructions, about AutoDesk AutoCAD Map are available 
at http://www3.autodesk.com/adsk/0,,129446-123112,00.html .  
 
Database Software 
 
The instructions are based upon the functionality and capabilities of Microsoft Access 2000 (Access) and Oracle 
8.17 (Oracle) database software.  Additional information, and more detailed instructions, about Access are available 
at http://www.microsoft.com/ms.htm.  Additional information, and more detailed instructions, about Oracle are 
available at http://www.oracle.com. 
 
Operating System 
 
The SDSFIE/FMSFIE software applications are tested for operation on Microsoft Windows 95, 98, ME, NT 4.0, & 
2000 operating systems.  Microsoft Windows 2000 Professional (Windows) was the operating system used during 
the preparation of this tutorial. 
 
SDSFIE/FMSFIE Release 2.00 Toolbox 
 
The SDSFIE/FMSFIE Toolbox is the term used by the CADD/GIS Technology Center when referring to the suite of 
software applications developed to facilitate the use and implementation of the SDSFIE/FMSFIE.  A brief explanation 
of the functionalities of each of the SDSFIE/FMSFIE Toolbox software applications is provided here.  Additional 
information is available from the CADD/GIS Technology Center at http://tsc.wes.army.mil, and the SDSFIE/FMSFIE 
Release 2.00 CD-ROM. 
 
Browser.  The Browser application provides the capability to view and print the various components of the SDSFIE.  
AutoCAD Map is now available for selection from the GIS application software tab. When Map is selected AutoCAD 
color values are displayed on the screens for Entity, Entity Type and Feature. In previous releases these colors were 
displayed as Red/Green/Blue (RGB) values.   
 
SQL Generator.  The Generator is the 32-bit companion product to the Browser, designed specifically for use with 
Windows 95/98 and Windows NT operating systems.  In addition to providing increased speed of Structured Query 
Language (SQL) code generation for use in constructing SDSFIE/FMSFIE compliant ANSI SQL (use with Intergraph 
RIS), Oracle SQL, Informix SQL, Microsoft SQL Server SQL databases, it offers a wider variety of generation options, 
as well as the capability to preview generated code and the ability to produce direct printed output as well as file 
output.  The generator builds SDSFIE data sets in three phases.  Each is capable of building the entire standard as 
well as some specific options permitting custom use.  
 
Access Builder.  This product is new to the SDSFIE/FMSFIE Release 2.00. It replaces, and expands, the capability 
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and functionality previously included in the Generator for building SDSFIE/FMSFIE compliant Access database 
tables.  The Access Builder allows the user to build an Access database by selecting the needed SDSFIE/FMSFIE 
tables, attributes and domains from an interface similar to the Browser. The software then builds the database table 
structure (complete with join relationships). 
 
Access Data Creator.  This product is also new to release 2.00. It allows the user to populate an Access database 
without Access. 
 
About AutoCAD Map 
 
Simply put, AutoCAD Map is AutoCAD with one additional menu, the Map menu. Using Map a user can create, 
maintain, analyze, and produce mapping information.  Map contains the object-oriented capabilities of AutoCAD 
software as well as its own unique spatial data management and multiple drawings access strengths.  With Map, a 
user can digitize, maintain, analyze, and plot maps and maps sets, and create thematic maps and legends.  A user can 
work with multiple drawings and use information from external data sources. 
 
With Map a user can: 
 
• Share files. 
• Manage, retrieve, and store both graphic and nongraphic data. 
• Link maps to associated databases. 
• Add data to maps and make them more intelligent. 
• Clean up maps. 
• Build node, network, and polygon topologies for analysis. 
• Produce thematic maps with legends. 
• Work with existing spatial data in other coordinate systems and file formats. 
• Import data from other CAD and GIS systems. 
• Export data to other formats. 
• Plot maps and map books easily and efficiently. 
 
In addition to creating maps, Map also acts as a GIS, allowing a user to develop topologies, a series of defined 
relationships between nodes, links, and polygonal regions.  A user can analyze this information and store polygonal 
or area-based data efficiently in topologies. 
 
With Map, A user can also link map features with text data from a database and store the data in the drawing file as 
object data or in an external database.  To find more information, a user can also define queries based on topology, as 
well as on object data or external database records.1 
 
 
 
 
 
 
 
 
 
 
 
 
1 Taken in whole or in part from AutoCAD Map 2000i Concepts; pp. 1-7
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About Relational Databases 
 
Database Management Systems (DBMS) are used to organize and tabular information for retrieval and manipulation 
by multiple users and application programs.  The RDBMS simplifies the structure with rows or columns of 
information.  Structured Query Language (SQL) is the American National Standards Institute (ANSI) standard 
relational database communication language.   The SDSFIE/FMSFIE SQL Generator provided with the CD release of 
version 2.00 of the SDSFIE/FMSFIE produces SQL statements that can be used to populate blank tables for various 
types of RDBMS including Standard ANSI, Microsoft SQL, Informix, and Oracle. 
 
Version 2.00 of the SDSFIE/FMSFIE introduced a separate tool for creating and maintaining Microsoft Access 
databases.  This SDSFIE/FMSFIE Access Builder not only performs many of the functions of the SQL Generator 
specifically for Microsoft Access, but also permits analysis and modification of the Access Schema, including 
definitions, domains and values, and expanded relationships.  The new tool is also useful in upgrading from one 
SDSFIE/FMSFIE Release to the next. 
 
About Access 
 
Microsoft Access is an interactive database management system designed for the Microsoft Windows operating 
system.  Access has the ability to integrate data from spreadsheets and other database formats.  The user can 
directly import, export, and create relationships to: Microsoft Excel version 3.0 or later, Microsoft Fox Pro version 2.x 
or later, Microsoft SQL Server, Borland dBASE III Plus, Borland dBASE IV, Borland dBASE version 5.0, Borland 
Paradox version 3.0 to 5.0, Microsoft Visual FoxPro version 3.0, Lotus 1-2-3, ASCII text and all ODBC-compliant 
databases. Access provides the ability to convert data or reports into HTML so the user can create interactive 
databases and share them across an Intranet or the World Wide Web. 
 
Microsoft Access takes advantage of the graphical user interface power and ease of use in Windows, giving the user 
visual access to data and simple, direct ways to view and work with information. 
 
Access provides querying and connective capabilities that allow the user to find desired information regardless of 
format or location. With the use of SQL queries, the user can work with data stored in different database formats and 
network locations.  The user can easily edit SQL statements at any time and view different layouts of data.   
 
Design tools included with Access allow the user to produce forms and reports to meet exact specifications.  One can 
plot data, combine different forms and reports in one document, and present reports with publication-quality style. 
 
Microsoft Access provides integration with Microsoft Visual Basic.  Integrated Development Environment (IDE) 
features drag-and-drop code, color-coded syntax, a debug window, and in-place object browsing.  Visual Basic for 
Applications – the programming language shared across all Microsoft Office applications – provides programming, 
interface, and debugging tools. 
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2 Implementation 

Tutorial 
 
This tutorial will outline the steps necessary to set up a SDSFIE/FMSFIE compliant database and attach it to a GIS 
(i.e., Map). Mock data for a storm sewer system will be imported into Access and attached to an existing AutoCAD 
drawing file. The following files have been delivered with this document for the tutorial. 
 
V-XPTUT1.DWG – Survey drawing of the existing site plan 
U-XPTUT1.DWG – Utility drawing of the Storm water piping plan 
Storm_pipe.txt – field collected data for the storm piping 
Curb_inlet.txt – field collected data for the curb inlets 
 
From Windows Explorer create the folder C:/acmaptut and copy the tutorial files into it. 
 
Obtaining Standard Symbology 
 
Within the SDSFIE/FMSFIE electronic deliverable the following symbology is provided: 
 
AutoCAD Blocks, each in an individual drawing file (.dwg). 
Patterns in a pattern library file (.pat). 
Multilines in a multiline library file (.mln). 
Custom line styles in a linetype library file (.lin). 
 
These files are stored in the directory /AutoCadSym.200. They are also available from the CADD/GIS Technology 
Center’s home page at http://tsc.wes.army.mil. Additional information pertaining to the use of these files is also 
available from the Center in a technical report titled A/E/C CADD Standard, dated October 1999. 
 
Implementation Preparation 
 
The first step in the implementation process is to perform an inventory of spatial data files requiring SDSFIE/FMSFIE 
compliance. A simple listing in a text file or spreadsheet serves well as a method to organize the data inventory. 
 
Next, select the features in the SDSFIE/FMSFIE that correspond to features in your existing data set.  The 
SDSFIE/FMSFIE Browser tool will help with the feature selection process.  This tool allows the user to browse 
compliant features by structure, feature name, key word, or data source.  The following steps demonstrate how to use 
the SDSFIE/FMSFIE Release 2.00 Browser application to find a few different features that would be included in a 
utilities spatial data set. 
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Using the SDSFIE FMSFIE Browser 
 
To open and configure the browser 
 
From the Windows Start Menu choose SDS FMS Browser 
 

1. From the Configure menu choose Connect. 
 
2. Verify and /or change the location of the data connection files and choose Connect, Test and Save. 
 
3. From the Configure menu choose Options. 
 

 
4. From the GIS Software tab choose AutoCAD/Map, then choose Apply. 
 

 
5. From the Special Features tab choose the appropriate settings, then choose OK. 
 
To browse by Structure 
 
Now look at all the Entity Classes in the Utilities entity set. 
 
1. From the Browse menu choose By Structure. 
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2. Choose Entity Sets, then double-click on utilities from the Entity Set window. 

 
3. Double-click on utilities_storm_system to view the full definition. 
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To browse By Feature 
 
Now find the entity definition for a stormwater pipe 
 
1. From the Browse menu choose By Feature. 

 
2. Double Click on Pipe – Storm Sewer Main in the features list to display the Entity Set, Entity Class, Entity 

Type, attribute table name and symbology for a stormwater pipe. 
 
To browse by Keyword 
 
Now find information about a curb inlet. 
 
1. From the Browse menu choose By Keyword. 
 
2. Enter “curb inlet” into the “Search For” field. 
 
3. Double-click on Feature name – CURB INLET in the keyword search results list to display the Entity Set, 

Entity Class, Entity Type, attribute table name and symbology for a curb inlet. 
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To browse by Data Source 
 
1. Now determine which domain table contains the FGDC vegetation classification for opentree. 
 
2. From the Browse menu choose Data Source 
 
3. Select FGDC Vegetation Classification from the Search for drop down list. 
 
4. Select all the Search in options, then choose Begin Search. 
 
5. Double-click the list domain value d_vegcls + opentree to view the domain table name, values and 

definitions. 
 

 
Continue using the Browser to gather pertinent information. 
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Using the Filter Maker 
 
The Filter Maker permits the development, definition, modification, implementation, and saving of a Filter, or subset 
of the entire SDSFIE Library.  A filter is used to limit the size of the data schema used as a part an SDSFIE/FMSFIE 
data implementation. Filters limit display and use of all aspects of the SDSFIE to include Entity Sets, Classes, and 
Types, as well as Tables, Attributes, and Domains.  A custom filter is a user-defined filter.  Although the creation of a 
custom filter is optional, it will greatly increase the efficiency of the SDSFIE/FMSFIE database generation process. 
 
For the purpose of this tutorial a filter named “Storm” will be developed.  The steps outlined in the following section 
guide the user through the tasks necessary to create the filter. *Note:  SDSFIE/FMSFIE data does not support filter 
operations with pre-TSSDS/TSFMS 1.80 releases. 
 
To open the Filter Maker and create a filter 
 
1. From the Windows Start Menu choose Filter Maker. 
 
2. Choose Connect to SDSFIE/FMSFIE Library. 
 
3. Verify and /or change the location of the data connection files and choose Connect, Test and Save. 
 
4. Choose Create a new filter, then choose Next. 
 
5. For the filter name enter Storm, then choose Next. 
 

 
6. Choose Save the contents of the storm filter, verify and /or change the location of the filter, then choose 

Next. 
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1. Choose Select Features Dialog, choose Features in selected Entity Class, then double-click 
utilities_storm_system. Choose Insert in Filter. 

 

 
2. Choose Next, then Create. 

 

 
3. Once the filter maker has completed the storm filter option will be available in the SDSFIE/FMSFIE Browser 

application. However this will not take effect until the SDSFIE/FMSFIE Browser application is restarted. 
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Erasing a Filter 
 
The Filter Eraser is used to restore the SDSFIE/FMSFIE Library to its original configuration.  It operates very similar 
to the Filter Maker (Wizard).  The following steps are to be used in erasing a user created custom filter (*Note: the 
SDSFIE/FMSFIE Filter Eraser is a separate program like the Filter Maker) 
 
1. From the Windows Start Menu choose Filter Eraser. 
 
2. Choose Connect to SDSFIE/FMSFIE Library. 
 
3. Verify and /or change the location of the data connection files and choose Connect, Test and Save, then 

choose Next. 
 
4. Choose the filter storm, then choose Next. 
 

 
5. Choose Erase. 
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Using the Access Database Builder 
 
New to release 2.00 of the SDSFIE/FMSFIE is the Access Database Builder. This tool automatically builds the 
structures (tables, attributes, and domains) of Access in accordance with the Spatial Data Standards. It replaces and 
expands on the functionality of the SDSFIE/FMSFIE Generator Tool first introduced in Release 1.600 of the TSSDS. 
This tutorial will use the builder to create a database structure used to store field captured data pertaining to the 
stormwater collection system. 
 
To open and build a database 
 
1. From the Windows Start Menu choose Access Builder. 
 
2. From the Open menu choose Create Access Database. 
 
3. For the database name enter storm, then choose OK. 
 
4. Choose Tables in Selected Filter and double-click storm to add all the storm system features to the 

Candidates List. 
 
5. Choose Add to Candidate List. 
 

 
6. From the Action menu choose Add Candidates to Access. 
 
7. Choose Build/Generate to convert the candidates to Access Tables. 
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Populating the SDSFIE/FMSFIE database 
 
The next step in the implementation process is populating the database.  Notice that when “Storm.mdb” was created, 
it was an empty database.  To use the database a user must populate it with the appropriate data.  The ASCII 
database files Storm_pipe.txt and Curb_inlet.txt contain field-collected attributes for the project. The following steps 
will populate the database. 
 
To open and convert the database to the latest version. 
 
This step is required since the Access Builder constructs an Access database in Access 97 format. 
 
1. From the Windows Start Menu choose Microsoft Access 2000. 
 
2. From the Tools menu choose Database Utilities > Convert Database> To Current Access Database Version. 
 
3. Navigate to the correct folder and select Storm.mdb. Save the new database as Storm2000. 
 
4. From the File menu choose Open, then choose Storm2000.mdb. 
 

To import the data 
 
1. From the File menu choose Get External Data> Import. 
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2. Change the file type to Text Files and import storm_pipe.txt. 
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3. Choose Delimited, then choose Next. 
 

 
4. Choose Comma as the delimiter, then choose Next. 
 

 



20 

5. Choose In an Existing Table, then choose the table utstopip from the dropdown list. Choose Finish. 
 
 

 
6. Open table utstopip to view the data. 
 

 
7. Repeat the process for table utstoinl using the text file curb_inlet.txt. 
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Using the Access Data Creator 
 
Use the Access Data Creator to populate a database without using Access. Open curb_inlet.txt in Notepad or Excel 
and leave open during the next few steps. 
 
To open the database and select a table 
 
1. From the Windows Start Menu choose Access Data Creator. 
 
2. From the Database menu choose Open, then navigate to C:/acmaptut and open storm.mdb. 
 
3. Choose the table utstoinl, then choose OK. 
 

To add a record 
 
1. From the Record menu choose New. 
 
2. Enter data as shown below. Choose save record when finished. 
 
3. Repeat the process for all the data in curb_inlet.txt. 
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4. From the Database menu choose Exit to close the program. 
 
AutoCAD Map Implementation 
 
The next step is to attach the data source to the GIS. Attach an Access database to Map by simply dragging the 
database file onto the Project Workspace (the Explorer like window to the left of the drawing area). Map automatically 
creates the files needed to communicate with Access. When reading external database files Map uses drivers to 
translate the data to a standard format. The first time you use a data source Map determines the appropriate driver 
and stores this information, along with the location and type of data source, in a Universal Data Link (UDL) file. 
 
To open Map and attach a database 
 
1. From the Windows Start Menu choose AutoCAD Map 2000i. 
 
2. From the File menu choose Open. 
 
3. Open U-XPTUT1.DWG. 
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4. Open an Explorer window in front of Map and navigate to C:/acmaptut. 
 

 
5. Drag Storm2000.mdb from the window into the Map Project Workspace. 
 

 
The tables are now listed under the data source storm2000 in the Project Workspace. 
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Using data view to view, hide and resize columns 
 
1. Double-click on table utstopip from the storm2000 data source. 
 
For this Tutorial, we will only work with the table "utstopip", and are not using the foreign key joins to other related 
SDSFIE/FMSFIE relational database tables (e.g., "map_id", "meta_id", "media_id", & "coord_id").  The 
SDSFIE/FMSFIE Compliance Policy provides complete information and guidance concerning refining and 
customizing SDSFIE/FMSFIE database tables.  
 
2. Right-click on the column heading map_id and choose hide from the menu. 
 

3. Do the same for columns meta_id, media_id and coord_id. 
 
4. Resize the columns by placing your cursor between the column headings and dragging left or right. 
 

The sort and filter functions are also available in Data View. 
 
To edit data 
 
1. Right-click on table utstopip from the storm2000 data source. 
 
2. Choose Edit Table from the menu. 
 
3. Make edits as necessary to the fields in the table, then close the table. 
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To define a Link Template 
 
When a drawing object is linked to a record in a database, link data is stored on the object, creating a relationship 
between the database table and the object. Map keeps track of these relationships using Link Templates. The Link 
Template stores the data source, table name and key column for a relationship. 
 
1. Right-click on table utstopip from the storm2000 data source. 
 
2. Choose Define Link Template from the menu. 
 

 
3. Choose stopipe_id as the key column, then choose OK. 
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To link a drawing object to a record 
 
1. Double-click on table utstopip from the storm2000 data source. 
 
2. Highlight the first record (P0001) by choosing the box at the beginning of the row. 
 
3. Right-click on the first record (P0001) and choose Link to Object(s). 
 

 
4. Choose the line that represents pipe 0001, then ENTER. 
 
5. Repeat step 4 until all of the records have been linked to objects. 
 
Now that the piping is complete try using the above process for the curb inlets. Use table utstoinl from the storm2000 
data source. Attach the records to the curb inlet blocks (named usincb). 
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To verify link template information 
 
Map attaches the key column value from the external database to the drawing object and stores it in the drawing. 
This information can be used to automatically reconnect drawing objects to their appropriate database records in the 
event an external database is moved or deleted. 
 
1. From the Map menu choose Database, then Link Manager. 
2. Select a pipe. 
 

 
 
To create a project 
 
1. From the Windows Start Menu choose AutoCAD Map 2000i. 
2. From the File menu choose Saveas. Save the drawing as PROJ001.DWG in C:/acmaptut. This is now your 

project drawing. 
 
To attach drawings to a project 
 
1. Right-click on Drawings in the Project Workspace and choose Attach. 
 

 
2. Choose Create/Edit Drive Aliases. 
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3. Enter proj001 for the Drive Alias and C:/acmaptut for the Actual Path, choose Add then Close. 
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4. Choose proj001 from the Look in list.  

 
5. Highlight U-XPTUT1 and V-XPTUT1, choose Add, then choose OK. 
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To query mapping 
 
1. Right-click on V-XPTUT1.DWG and choose Zoom Extents. 
 
2. Right-click on Current Query under Query Library in the Project Workspace. 
 
3. From the menu choose Define. 
 

 
4. Choose Location, choose All, choose OK. 
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5. Under Query Mode Choose Draw 
 

 
6. Choose Execute Query. 
 
7. The drawing should look like this. 
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To alter properties when querying objects 
 
1. Right-click on U-VPTUT1.DWG under Drawings in the Project Workspace. 
 
2. From the menu choose Deactivate. 
 

 
3. Right-click on Data Sources in the Project Workspace. 
 
4. Choose Attach. 

 
5. Choose Storm2000.udl, Then choose OK. 
 

 
6. From the Format menu choose Layer. 
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7. Freeze the piping layer, then choose OK. 
 

 
8. Right-click on Current Query under Query Library in the Project Workspace. 
 
9. From the menu choose Define. 
 
10. Choose Clear Query, then choose Property. 
 
11. Choose Layer, then choose Values. 
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12. Choose the main sewer line layer, choose OK, then choose OK. 

 
 
13. Under Options, check the box next to Alter Properties, then choose Alter Properties. 
 
14. Under Select Property choose Layer, enter pipe_by_matl in the Expression Box, then choose Add. 
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15. Under Select Property choose Color, then choose SQL. 

 
 
16. Choose utstopip from the Link Table list, choose MAT_D, then choose OK. 
 

 

17. Choose Ranges, choose New, then enter matl_by_color for the Range Table Name. 
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18. Under Condition enter CONCRETE in the Expression Value and 5 in the Return Value. Choose Add. 

 
 
19. Enter HDPE in the Expression Value and 6 in the Return Value. Choose Add, Then OK. 
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20. From the Range list choose matl_by_color, choose Add, then choose OK. 

 
 
21. Choose Execute Query. 
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Issues with Oracle 
 
There are a few additional steps required to use Oracle as a data source. 
 
Using the SQL Generator 
 
To configure the SQL Generator 
 
1. From the Windows Start Menu choose SQL Generator. 
 
2. From the Configure menu choose Connect. 

 
 
3. Verify and /or change the location of the data connection files and choose Connect, Test and Save. 
 
4. From the Configure menu choose Configuration. 
 
5. Under GIS Application Configuration choose AutoCAD/Map. 
 
6. Under Database Configuration choose Oracle SQL. 
 

 
To generate tables and attributes 
 
1. From the Generate menu choose New, then Table and Attributes. 
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2. For the Ge neration Mode choose Custom Filter Schema, then double-click storm custom filter. 
 

 
3. For Generate to choose C:\…\TSSDS\Generate\SQLCode.SQL to save your code to a file. 
 
4. Choose Generate then Close. 
 
5. From the Windows Start Menu choose Windows Explorer. Navigate to the directory containing 

SQLCode.SQL and rename the file to storm_table_att.SQL. 
 
To generate domains and values 
 
1. From the Generate menu choose New, then Domains and Values. 
 
2. For the Generation Mode choose Prior Generation. 
 

 
3. For Generate to choose C:\…\TSSDS\Generate\SQLCode.SQL to save your code to a file. 
 
4. Choose Locate Generation SQL, choose the file storm_Table_Att.SQL, then choose OK. 
 
5. Choose Generate, then Close. 
 
6. In Windows Explorer rename SQLCode.SQL to storm_Domain_Val.SQL. 
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To generate join/table relationships  
 
1. From the Generate menu choose New, then Domains and Values. 
 
2. For the Generation Mode choose Prior Generation. 
 

 
3. For Generate to choose C:\…\TSSDS\Generate\SQLCode.SQL to save your code to a file. 
 
4. Choose Locate Generation SQL, choose the file storm_Table_Att.SQL, then choose OK. 
 
5. Choose Generate, then Close. 
 
6. In Windows Explorer rename SQLCode.SQL to storm_Join_table.SQL. 
 
Compiling SQL Code in Oracle 
 
To create a user 
 
Due to the complexity of Oracle the task of assigning usernames is usually assigned to a qualified Oracle Database 
Administrator. This tutorial uses the username mapuser with the password acadmap. 
 
Using SQL+ Worksheet 
 
SQL+ Worksheet is a utility supplied with Oracle that aids in loading and compiling SQL. Have a DBA run the 3 SQL 
files created from the SQL Generator in SQL+ Worksheet to create an empty database structure. 
 
To populate the database 
 
Once again the task of importing the 2 text files into a newly created data structure should be preformed by a DBA. 
 
Configuring an Oracle Database in Map 
 
Configuring an external Oracle database for use with AutoCAD Map requires the use of the Oracle Provider driver. 
This driver is loaded during the initial installation of Map. Unlike Access, the process for using Oracle as your data 
source is not as automatic. The user will have to manually create a DSN and UDL file. 
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To set up an ODBC 
 
1. From the Windows Start Menu choose Settings, then Control Panel. 
 
2. In the Administrative Tools folder double-click on Data Sources (ODBC). 
 
3. Under the System DSN tab choose Add. 
 

 
4. Choose Microsoft ODBC for Oracle from the driver list, then choose Finish. 
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5. Enter a Data Source Name (DSN) and the Server Name (supplied by DBA). This tutorial uses acadmap for 
the DSN and acadmap for the Server. 

 

  
6. Choose OK then OK. 
 

 
Configuring a Data Source in AutoCAD Map 
 
Open a new drawing in Map for this next step. 
 
To manually configure a data source 
 
1. From the Map menu choose Database> Data Sources> Configure. 
 

2. Enter acadmap as the DSN and choose OK. 
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3. Under the Provider tab choose Microsoft OLE DB Provider for ODBC Drivers, then choose Next. 
 

 
4. Under the connection tab choose acadmap from the DSN list, then enter the username and password 

(mapuser and acadmap in this case). 
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5. Choose Test Connection to verify connection to the database, then choose OK. 
 

 
To attach a data source 
 
1. Right-click on Data Sources in the Project Workspace. Choose Attach. 
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2. Choose acadmap.udl, then choose Open 

 
 
3. Enter the username, password (acadmap, in this case) and server, then choose OK. 
 

 
Using data view to view data 
 
1. Double-click on table mapuser.utstopip from the acadmap data source. 
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